
 

Chapter 1

 

Life beyond the Basic Word

 

Pretty much anyone can

 

 use a computer and figure out how to use Word. The program has 
been so successful that it’s essentially unchanged from its Word 97 version. The name of the game 
is to get your stuff down on paper and make it look good. The rules are easy. This chapter here elab-
orates on some of the more basic concepts you may not know, plus a few new rules and tricks designed 
to help you make your word processing chores all the easier:

 

◆

 

Helpful hints on properly saving your stuff

 

◆

 

Password protection advice

 

◆

 

Better ways to cut and paste and search and replace

 

◆

 

Resetting defaults without messing with 

 

NORMAL.DOT

 

◆

 

Making the spell checker behave

 

◆

 

Printing a document backward

 

◆

 

Setting margins for printing on three-hole-punch paper

 

◆

 

Printing two pages per sheet

 

Saving and Opening Documents Can Be Torture 
if You Don’t Know a Few Things

 

Save now! Save early! Save often!
The three biggest issues whenever you save a document (in Word or in any application) are

 

◆

 

The document’s name

 

◆

 

The document’s location

 

◆

 

The document’s type
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The Save As dialog box (Figure 1.1) handles all these details for you, which is basic baby Windows 
stuff. Of course, that doesn’t mean you can’t screw them up. So heed these words of advice before get-
ting into the intermediate-level knowledge nuggets:

 

Figure 1.1  

 

Your typical Office 
Save As dialog box

 

First, the document name must be descriptive of the contents. You have up to 200 characters to 
use for the name, including numbers and letters and a smattering of symbols, but brief is best.

Second, be thoughtful of the file’s final folder destination. Don’t just shove everything into the My 
Documents folder. Organize. Use subfolders. In fact, the filename can be simpler if the folder it lives 
in is more descriptive. Consider this: The file is named 

 

14.DOC

 

. But it lives in the October folder. And 
that lives in the 2004 folder. And that lives in the Letters to the Editor folder. Consider:

 

Letters to the Editor/2004/October/14.doc

 

versus a single file in the My Documents folder:

 

Letter to the editor on October 14.doc

 

Finally, there is the document file type, which is found in the bottom part of the Save As dialog 
box. You can use that list to save or 

 

export

 

 your document into a variety of different word processor 
formats. Most often you’ll be using the Word Document format (thus a 

 

.doc

 

 extension on the file), 
but be careful not to neglect the power that drop-down list gives you—and to avoid the confusion 
that can result should you choose the wrong option.

 

Why Save a Document in Another Format?

 

The primary reason for 

 

not

 

 using the Word Document file format is to share your stuff with some 
loser, uh, I mean someone who doesn’t have Word as his or her word processor. For example, if they 

Main
folders

and such
live over

here.

The
Tools
menuOpen other folders

from here.

Filename goes here.

Important file type
info goes down here.

Choose a folder or
disk drive from here.

Create a
new folder.
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have WordPerfect, you can choose one of the WordPerfect file formats from the Save as Type drop-
down list (Figure 1.1).

Another instance may be where you have to save a document in plain text format. For example, say 
you deleted something important in Windows and you have to replace it by creating a list and saving it 
to disk as an ASCII or text file. If so, choose “Plain Text (*.txt)” from the Save as Type drop-down list.

 

Note

 

The best non-Word format to choose is the Rich Text Format (

 

*.rtf

 

). That format is the most common among
all the major word processing applications for most computers. In fact, I would save a document as RTF instead of
attempting to save in WordPerfect or even HTML format; it’s just that much more common—and better.

 

Should I Ever Have to Save a Document as a Web Page?

 

My advice is never to use any web page or HTML format in the Save As dialog box, and by all means 
avoid the File �

 

 Save as Web Page command. These options are designed for those who use Word 
as their web page editor. The problem with that is that Word is not a very good web page editor. (I’ve 
even gotten Microsoft personnel to admit that—off the record.)

There may be some time when you need to “share” your precious Word document with others, 
and the suggested format may just be HTML. If so, then go ahead and use the File �

 

 Save as Web 
Page command to create the HTML document. I suppose if your hands are tied to doing that, then 
do that you must. But don’t make it a habit if you can help it.

 

Why Does the Document Open All Weird?

 

Again, you can blame the Save as Type drop-down list for any weirdness that happens when you open 
a document, though in this case the weirdness takes place in the Open dialog box with the Files of 
Type drop-down list, as shown in Figure 1.2.

 

Making a Longer Recently Used File List

 

Without otherwise scolding Word into action, the recently used file list keeps track of only the last four
files you’ve opened, saving their names at the bottom of the File menu. You can adjust the number of file-
names Word remembers up or down, depending on your whim:

 

1.

 

Choose Tools �

 

 Options.

 

2.

 

In the Options dialog box, click the General tab.

 

3.

 

Adjust the value by the “Recently Used File List” item (which must be checked on). Values can go from
1 through 9. To choose zero, just uncheck the box.

 

4.

 

Click OK.

I personally like having only four items, though when I’m doing a big project and shuffling files quite a bit,
six seems like a more logical value.
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Figure 1.2  

 

The typical Open 
dialog box for Office

 

The Files of Type drop-down list not only tells Word which types of files to display in the Open 
dialog box, but it tells Word how to open the files as well.

For example, if you choose the option “Recover Text from Any File,” then Word dutifully does 
that—even to its own files. So if that option is chosen and you open a Word document, you will see 
junk on the screen.

The solution is to pay attention to the file type choices in the Open dialog box. If the document 
looks like junk, then follow these steps:

 

1.

 

Immediately close the weird document; do not save it to disk.

 

2.

 

Choose File �

 

 Open to bring up the Open dialog box again.

 

3.

 

Confirm that the proper type is chosen in the Open dialog box.

 

4.

 

Open the file.

 

Note

 

Be careful 

 

not

 

 to save the file if it’s opened in a weird format. If you do so, then you cannot recover the original.
Uh-oh! (As a suggestion, consider using Windows to make a copy of the original; then work on the copy only.)

What’s shown up
here is chosen by the…

…file type here.

 

Just Your Basic Open and Close Keyboard Commands 

 

Here are the keyboard commands used in Word, as well as other Office and Windows applications, for the
standard operations of opening, closing, and saving documents:

 

Ctrl+S

 

Save the document to disk, or summon the Save As dialog box if the document has yet to 
be saved.

 

Alt+F, A

 

Specifically summon the Save As dialog box.

 

Ctrl+O

 

Open a document previously saved to disk.

 

Ctrl+W

 

Close a window, prompting to save the document if it’s unsaved.

 

Continued on next page
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Can I Password-Protect My Document?

 

Certainly! After summoning the Save As dialog box, use the Tools menu to modify the way the file 
is saved to disk. (Refer to Figure 1.1.)

 

1.

 

In Word 2003/XP, choose Tools �

 

 Security Options; in Word 2000, choose Tools �

 

 Gen-
eral Options. The Save or Security dialog box appears, such as shown in Figure 1.3. It’s very 
similar for all versions of Word, though the location of the open and modify password text 
boxes is different.

 

2.

 

If you like, enter an open password. This password prevents the document from being opened 
unless the person knows the password.

 

Figure 1.3  

 

Entering a password 
or two for your 
document

 

When used with the Shift key, the commands apply to all open Word windows:

 

Shift+Ctrl+S

 

Save all open documents.

 

Shift+Ctrl+W

 

Close all open windows.

Finally, from before Windows was standardized, there are some leftover keyboard commands from the
very early days of Word:

 

F12

 

Summon the Save As dialog box (even for an already-saved document).

 

Shift+F12

 

Save the document to disk.

 

Ctrl+F12

 

Summon the Open dialog box.

 

Just Your Basic Open and Close Keyboard Commands

 

(continued)

Choose the type
of encryption here.

Password restricts all
access to the file.

Password prevents file
from being modified.

Other ways to track/
protect against editing

this document

Other stuff
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3.

 

If you like, enter a modify password. This password allows the file to be opened as a “read-
only” document. If they know the password, however, then they can modify the document.

 

Note

 

Passwords are case-sensitive. They consist of up to 15 letters and numbers. Do not forget them or you’re
screwed!

 

4.

 

Click OK after entering one or both passwords. If you don’t enter any passwords, then the doc-
ument is not protected.

 

5.

 

Confirm the password(s). Type them again to ensure that you remember them. Don’t forget 
them!

 

6.

 

Continue using the Save dialog box to save the file to disk.

The password-protected file doesn’t look any different on disk, nor does it look any different 
when you’re working on it in Word. But once you close the document, the password encryption takes 
over, and only by knowing the password can you get at the document’s contents.

When you go to open a password-protected document, either in Word or by double-clicking the 
document’s icon in Windows, you’ll be presented with a Password dialog box or two. The first may 
be required for merely opening the document—that’s the open password.

A second dialog box, such as the one shown in Figure 1.4, is the modify password dialog box. Note 
that there is a Read Only option in that dialog box in case you do not know the password; only by 
entering the password can you modify the document.

 

Figure 1.4  

 

Oops! Better know 
the password to mod-
ify that document!

 

Note

 

Actually, you can use the Save As command in any read-only Office document to save that document to disk
using another filename. Then you can open that second document for editing. (Sneaky, but it works.)

 

Can I Remove the Passwords from a Password-Protected Document?

 

To remove the passwords, simply repeat the steps from the previous section, but leave both password 
input boxes blank. Click OK, and that resets the passwords back to nothing, and there are no more 
restrictions on opening or modifying the file.

Guilty party who
applied password

Filename

Enter password or just…

…Click here to open as read-only.
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But I Forgot the Document’s Password!

 

You’re screwed. Really. Don’t be dumb: follow these handy password-remembering rules:

 

◆

 

If you feel you’re going to forget your password, then write it down! But don’t write it down 
on a sticky note and stick it on the monitor. Instead, put it in your day planner, perhaps on the 
bottom of the page with your birthday. But whatever you do, write that password down so you 
can at least find it later.

 

◆

 

Shorter, memorable passwords work best.

 

◆

 

Passwords mixing letters and numbers are also good, such as the number and street where you 
used to live or where a relative lives.

 

◆

 

There is also a school of thought that absurdity often makes a memorable password. For example, 
stick together two obnoxiously unrelated words like “baby-meat” or “armored-nun.”

Finally, there is really no hope if you forget your password. Microsoft cannot help you, nor are 
there any secret tools or tricks available on the Internet. So remember that password!

 

I Can’t Find My Document!

 

If you’re missing a document, then you have a few tricks you can pull before you consider tossing the 
computer before an oncoming train.

First, check the File menu. Is your document down near the bottom, in the list of recently used 
files?

Second, check the Documents or My Recent Documents submenu from the Start button. Is the 
file listed there?

Third, you can use Window’s Find or Search command to look for the document, but you can also 
use the Find or Search command in the Open dialog box to help you quickly find your document 
based on its contents. Follow these steps for your version of Word.

 

Finding a Wayward Word File in Word 2003/XP

1.

 

Summon the Open dialog box.

 

2.

 

From the Tools menu, choose Search. The File Search dialog box appears, and like its ances-
tors it’s too vast and ugly to reproduce on these pages. But fortunately it’s not as complex or 
weird as the Word 2000 variation.

 

3.

 

Make sure that the Basic tab is showing, not the Advanced tab.

 

4.

 

Type some words from your document into the Search text box. For example, that letter to the 
editor you wrote comparing the snow plow driver to Adolf Hitler. If you lost that document, 
then consider searching for the words “Hitler” and “snow plow” to find what you want.

Fortunately, all the other settings are made for this type of search (the most common), so…

 

5.

 

Click the Search button.
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6.

 

Eventually a list of matches appears, which you can sift through. Click the file you want to 
check out.

 

7.

 

Click the OK button.

 

8.

 

Back in the Open dialog box, click the Open button to open the file.

If the list appearing in the File Search dialog box is 

 

way too long

 

, then you’ll need to rethink your 
approach. Try using more specific words, or click the Advanced tab and heed these instructions:

 

1.

 

From the Property drop-down list, choose Contents. Not “Comments” but “Contents.”

 

2.

 

Enter the words you’re searching for in the Value text box. For example, “Hitler” and 
“snow plow.”

 

Note

 

If the words appear together in your document, then surround them with double quotes. “Snow plow” searches
for the word “snow” followed by “plow.” But if you type each word individually, then the document can contain either
word in any order any number of words apart.

 

3.

 

Click the Add button.

 

4.

 

Now you can enter another bit-o-information to search for. From the Property drop-down list 
choose “Creation Date.”

 

5.

 

From the Condition drop-down list choose an option, such as “On” or “On or After” or 
“This Week.”

 

6.

 

If you chose a condition that requires a date, then enter the date in the Value text box.

 

7.

 

Click the Add button.

 

8.

 

Now you have two search criteria, which should be enough. Click the Search button.

And off Word goes to look for the document matching your specifications.

 

Locating Lost Documents in Word 2000

1.

 

Summon the Open dialog box.

 

2.

 

From the Tools menu, choose Find. The Find dialog box appears, but it’s much too complex 
and obtuse to show here in a figure.

 

3.

 

From the Property drop-down list, choose Contents. The Condition drop-down lists self-
modifies to say “Includes Words.”

 

4.

 

Type some words from your document into the Value text box. For example, if you lost the 
document about how you cheated the Brundlemans at cards, then searching for the words 
“Brundleman” and “cards” would most likely yield successful results.
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5.

 

Click the Add to List button. Ah-ha! This is the step everyone forgets (and the reason they 
changed all this with Word XP). If you forget to click the Add to List button, you’ll be 
reminded to do it later.

 

6.

 

Optionally choose a location from the Look In drop-down list. It already shows you the My 
Documents folder, which is an ideal place to look. But if you feel the file is on a disk in another 
drive or a specific folder, then choose it from the list as well. To search the entire computer, 
select My Computer from the list.

 

7.

 

Put a check mark by “Search Subfolders” so that the search expands down into the very depths 
of your disk drive’s folder structure.

 

8.

 

Click the Find Now button. Word scurries around the folders you told it to look in and finds 
all files matching your search criteria. They appear in a tree structure that unfolds in the Open 
dialog box.

 

Note

 

If a multitude of files were found, then consider redoing the search with more specific information, or even repeat-
ing steps 3 through 5 and adding a range of dates to narrow the search.

9. Ctrl+click to select all the files found.

10. Click the Open button to open all the selected files. Now you can sift through each of them 
in Word until you find the one you want.

Yes, it’s possible to open more than one file at a time in the Open dialog box. The Open button 
opens any and all selected files shown in the list.

Fixing the Stupid Menus!

Tired of the menus in Office changing size on you? Sick of having to click the “show more” chevron to see
the entire menu? Me too! A program should never conceal its options. So to fix Word’s timidity of its own
menus, follow these steps:

1. Choose Tools � Customize.

2. Click the Options tab in the Customize dialog box.

3. In Word 2003/XP, click to select “Always Show Full Menus;” in Word 2000, remove the check mark by
“Show Full Menus after a Short Delay.”

4. Click OK.

That way the menus stay open and visible all the time. It’s also the way I prefer to use Office applications,
and the way they’re shown in the screen shots in this book.
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How Do I Save a Document to Drive A?
You can save a document to any disk in your system, whether it’s another hard drive or a removable 
disk such as a floppy, Zip, or writable CD or DVD. The secret is to choose that disk from the Save 
In drop-down list at the top of the Save As dialog box (see Figure 1.1).

Please don’t try to save to Drive A—or any removable disk—as opposed to using the hard drive. 
The hard drive is designed to be your primary file storage location. Use it! Then, after the file is safely 
saved on the hard drive, consider using the Save As command to save a copy of the file to a removable 
disk. Or you can use Windows to simply copy the document to a removable disk.

Note Floppy disks are notoriously unreliable. They’re fine for backups or for moving files between computers, but not
for permanent storage.

Word Crashed! What Can I Recover?
Word is smart about document recovery. If there is anything to recover, then you’ll see that file appear 
in a window the next time you start up Word. The window will have the original file’s name followed 
by the text “(Recovered).”

In Word 2003/XP, point the mouse at the recovered file, and a menu button appears. Click that 
button to select a recovery option.

In Word 2000, use the Save As dialog box to save that recovered file back to disk and overwrite 
the original.

Yes! It’s okay to overwrite an original file with a recovered version. I would say 99 percent of the 
time that’s the option I’ve chosen. (The other 1 percent of the time the recovered file was no different 
from the original.)

Of course, to make Word recover files, you need to turn on the AutoRecovery feature:

1. Choose Tools � Options.

2. Click the Save tab.

3. Put a check mark by “Save AutoRecover Info Every” (if a check mark isn’t there already).

4. Enter a time interval to save the AutoRecover information. Ten minutes is okay for most people.

5. Click OK.

Now your computer is semiprotected against bad things happening. Word will automatically save 
your documents (whether you do or not) every 10 minutes or so. Of course, nothing gets hurt by your 
pressing the Ctrl+S key combination every few minutes just to be safe.

Note If there are no recovered documents after a crash, then don’t worry. Your stuff was probably all up-to-date and
there was nothing necessary for Word to recover.
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A Gaggle of Nifty Word Formatting and Editing Tricks
Just when you think you know every Word trick there is, some doofus pops up and shows you some-
thing new, something useful, something you wish you would have known for the last project you did. 
Well, for the next few pages I plan on being your personal doofus and showing you what I think are 
some handy, unknown, or under-used tools in the Word toolbox.

How Do I Select Only One Sentence of Text?
A sentence is an irregular beast, not a single word or paragraph. Therefore selecting it using the mouse 
or the keyboard requires tedious skill...unless you know this trick: Press the Ctrl key and click the 
mouse somewhere in the sentence. Zloop! The entire sentence is selected and ready for action!

And for your passing enjoyment, Table 1.1 lists other quick and nifty ways of instantly select-
ing text.

Can I Change the Capitalization without Retyping the Whole Sentence?
The easiest way to change capitalization of a word is to put the insertion point in the word and press 
Shift+F3. That changes the capitalization to one of three modes: Initial Caps, ALL CAPS, or all low-
ercase. Keep pressing Shift+F3, toggling back and forth until you get the capitalization you want.

As an alternative, you can select the text you want to recapitalize and choose Format � Change 
Case from the menu. Doing so displays five options for changing the case of the selected text, as 
shown in Figure 1.5. Select an option and click OK.

Figure 1.5  

Even more ways to 
change the case

Table 1.1: Selecting Chunks of Text in Word

To Select This 

Chunk of Text Take This Action Or This One

Word Double-click the word. With the insertion point in the word, 
press the F8 key twice.

Sentence Ctrl+click the sentence. With the insertion point in the sentence, 
press the F8 key three times.

Line Click in the margin to the left of the line.  

Paragraph Double-click in the margin to the left of the 
paragraph.

With the insertion point in the paragraph, 
press the F8 key four times.

Capitalizes only the first
character of the sentence.

All lowercase
All uppercase

Capitalizes each word in the sentence.
Switches all uppercase letters

to lowercase and vice versa.
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Note Despite the earnestness of the Change Case command (Shift+F3) referring to its Initial Caps command as
“Title Case,” it is a common convention not to capitalize prepositions, articles, or conjunctions in a title. So, words such
as of, in, and, on, by, with, for, and so on are not capitalized, well, unless they appear at the start or end of the title.
(I asked my editor about this issue and she trembled in fear, citing some obscure tome called the Chicago Manual of
Style. But then she also mentioned about 1,600 exceptions. So I suppose whatever you capitalize in your title is okay
with me.)

How Can I Paste in Text without Pasting in All the Formatting?
I suppose it’s handy that when you normally paste text into Word, all the text’s original formatting 
follows along like so much emotional baggage. For example, if you copy text from a web page into 
Word, you’ll notice that any formatting the text had on the web page automatically follows that text 
into Word.

If you don’t want the formatting to follow the text—for example, you want the text to appear in 
the document using the document’s own formatting styles (just as if you had manually typed the text 
yourself), then you need to know how to Paste Special. Obey these steps:

1. Choose Edit � Paste Special. The Paste Special dialog box appears.

2. Choose “Unformatted Text” from the list.

3. Click the OK button.

And the text is pasted into the document minus any formatting it may have had. The end result is 
text that appears as if you’ve typed it yourself.

In Word 2003/XP, you can choose the Unformatted option after you paste the text by clicking 
the Paste Options button that appears after the text has been pasted. Choose “Keep Text Only” 
from the pop-up menu, and it’s the same thing as pasting in unformatted text.

Note If there isn’t an “Unformatted Text” option, then there is no text in the Clipboard to paste. Also note that you
can Paste Special only from the Paste Special dialog box, not from the Clipboard task pane in Word 2003/XP.

What the Heck Is Wrong with This Formatting?
Most of the e-mail questions I get regarding Word deal with some sort of weird formatting, such as 
a blank at the start of each line or a border following random paragraphs. Fortunately, nothing in 
Word is truly hidden from you. And while Word lacks a Reveal Codes command (that I so loved 
back in the days of DOS WordPerfect), it does have a Show Formatting command.

To see what evils lurk in a paragraph’s formatting, press the Shift+F1 key combination. This has 
two different effects, depending on your version of Word.

In Word 2000, the mouse pointer changes to a question mark–arrow, which you can use to point-
and-click at any text in Word. Doing so displays a pop-up cartoon bubble that lists the formatting 
for whatever text you clicked on, as shown in Figure 1.6.
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Figure 1.6  

Checking the 
text formatting in 
Word 2000

The problem here is that only information is displayed. It’s up to you to figure out where the prob-
lem lies, not only from the terms used in the description but from knowing which Word commands 
control those formatting options. (Fortunately all formatting options exist in the Format menu.)

In Word 2003/XP, information about the formatting appears in the Reveal Formatting task 
pane, as shown in Figure 1.7. This is very similar to the information shown for Word 2000, but with 
the advantage that you can click the underlined (blue) links to get at the proper dialog boxes required 
to fix things.

Figure 1.7  

Checking the for-
matting in Word 
2003/XP

How Come Changing the Format of One Paragraph Changes the Formatting 
of Them All?
I encountered this problem a while back and it bugged the bejoobies out of me: whenever I made one 
line of text bold, every other paragraph in the document bolded up. Very annoying, until I figured out 
that it was a Style issue.
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Styles can be programmed to be automatically updated. So when you modify a paragraph in a doc-
ument, all other paragraphs formatted with that style also change. This can be handy if you like to 
mess with styles after they’re created, but it can also be a pain in the butt. To fix it, you must visit the 
Style dialog box:

1. Put the insertion pointer in the paragraph having the style you need to fix.

2. Choose Format � Styles and Formatting in Word 2003/XP; choose Format � Style in 
Word 2000.

3. Choose Modify from the drop-down list next to the highlighted style in the Styles and For-
matting Task Pane in Word 2003/XP; in Word 2000, click the Modify button in the Style 
dialog box. The Modify Style dialog box appears.

4. Uncheck the item that reads “Automatically Update.”

5. Click OK.

With the Automatically Update option disabled, your document’s paragraphs can be modified 
without changing the underlying style. Or, conversely, if you do want styles to be updated on the fly, 
then you can check that option so that changes to one paragraph affect all other paragraphs of the 
same style. (But either way, I find it annoying.)

Why Would I Want to Search and Replace Styles?
Word’s Search and Replace function is powerful enough to wreak havoc on even the most innocent 
of things, such as a style. So suppose you discover that for some arcane legal reason all your italic text 

The Mighty F2 Key

One of the easiest ways to copy or move a block of selected text in Word is to employ the handy F2 key. Unlike
any of the other 10,000 ways to copy or move text, F2 is a breath of fresh air, giving you an immediate com-
mand versus a combination of commands or windows or prayers and incantations. It works like this:

1. Select the text you want to move or copy.

2. Press the F2 key to move that text, or press Shift+F2 to copy. You’ll see “Move to Where?” or “Copy to
Where?” appear on the status bar.

3. Click the mouse where you want the text moved. You can scroll to anywhere else in the same docu-
ment, but you cannot use this trick to move or copy between two different documents.

4. Press the Enter key to move or copy the text.

Note that moving or copying text in this manner does not place that text into the Clipboard for repasting.
No, the F2 command is more of a quick-move/quick-copy command than a traditional copy- or cut-and-
paste operation.
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has to be changed into boring old underline. Here’s how you can do that without wasting a ton of 
time by using the Search and Replace command:

1. Press Ctrl+Home to zip to the tippy-top of your document.

2. Choose Edit � Replace. The Find and Replace dialog box appears, ready to “Find What” and 
“Replace With.” But you need more information than that, right?

3. Click the More button. More stuff appears!

4. Click the Format button.

5. Choose Font from the pop-up menu. The standard Font dialog box appears.

6. Choose Italic in the Find Font dialog box, or select whatever font attributes you’re search-
ing for.

7. Click OK. 

Now notice in the Find and Replace dialog box how the text “Format: Font: Italic” appears 
below the Find What text box. That means Word is searching for a format, not a specific 
chunk of text. The format it’s searching for is any text that’s italic. Time to select what to 
replace the italic text with:

8. Click the mouse in the Replace With text box.

9. Click the Format button.

10. Choose Font from the pop-up menu.

11. Choose the solid underline from the Underline Style drop-down list. That’s the replace-
ment style.

12. Click OK. Now under the Replace With text box you’ll see “Format: Underline.” You’re 
searching for italic text and replacing it with underline—a style or formatting search and 
replace instead of a text search and replace.

13. Click the Replace All button to convert all your document’s italic text into Underlined text.

You can search and replace any formatting attribute with any other formatting attribute, including 
text color, paragraph formatting, even styles you’ve created. Just choose the proper formatting com-
mand from the Format button.

Note Word remembers the last formatting item you searched and replaced! To clear the formatting information from
the Find and Replace dialog box, click the No Formatting button. If you forget to do this, then Find and Replace will not
behave as you expect it to.
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Where Was I Last Editing?
A handy key to remember is the Shift+F5 combination. Pressing Shift+F5 returns the insertion point 
back to the place in your document where you last edited. So if you’re scrolling through text reading, 
or bouncing from here to there editing, remember Shift+F5 to return to where you once were.

Is There an Easier Way to Edit a Document Full of Pictures?
Word doesn’t do desktop publishing very well. Instead of forcing too many pictures into Word, I rec-
ommend using a “real” desktop publishing program, such as Microsoft’s Publisher or Adobe’s InDe-
sign. But anyway...

If you’re suffering through a document that has lots of pictures and it seems to be slowing things 
down, then shift into this mode:

1. Choose Tools � Options.

2. Click the View tab in the Options dialog box.

3. Put a check mark by “Picture Placeholders.”

That replaces the images in your document with placeholders, which makes scrolling around work 
a lot easier. When you’re done editing, simply repeat the above steps to reactivate the pictures.

Why Would I Need the Document Map?
The Document Map is one of those seldom-used features that can really save you time both navigat-
ing a larger document and getting “the big picture” on what you’re writing.

To switch on the Document Map, choose View � Document Map from the menu, or click the 
Document Map button on the toolbar. A slice of the screen is split off to show you the various head-
ings in your document, as illustrated in Figure 1.8.

Alas, if your document lacks headings, doesn’t use the Headings styles, or is too short, then the 
Document Map isn’t of much help.

Choose View � Document Map again, or click the toolbar button, to make the Document Map 
view vanish.

Figure 1.8  

Viewing the Docu-
ment Map

Headings in the
document

The document itself

Click a heading to
visit that section.
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What’s the Point of NORMAL.DOT?
NORMAL.DOT is a template file, not a document. As such, it is the standard (or “default” if you want) 
template used by Word whenever you open a new document and don’t specify any other template. 
It contains the standard settings for any new document, such as Times New Roman font at 12 points, 
single-spaced, and so on. (See Chapter 5, “Using Styles and Templates to Save Oodles of Time,” for 
more information on templates.)

If you want to change the way Word starts new blank documents, then you merely need to edit 
the NORMAL.DOT template and update the settings. NORMAL.DOT can be opened like any template file in 
Word, edited, then saved back to disk. The secret is to choose “Document Templates (*.dot)” from 
the Files of Type drop-down list in the Open dialog box.

A better way to make subtle changes in the NORMAL.DOT file is to take advantage of the various 
Default buttons located in many of Word’s dialog boxes. These buttons can be used to modify 
the NORMAL.DOT template without having to go through the ordeal of trying to find it on disk and 
opening it.

For example, say you want all your new documents to be in the Bookman font at 10 points. Just 
choose Format � Font and select Bookman as the font and 10 points as the size. Then click the 
Default button. Word asks if you want to save that change to the NORMAL.DOT template, making it 
stick for all new documents you open (Figure 1.9). Click Yes to make it so.

Figure 1.9  

Changing the 
default font

There are other Default buttons in other formatting dialog boxes as well. These also modify the 
settings of the NORMAL.DOT template. Use them to change the settings for your new, blank documents.

Note NORMAL.DOT also contains any modifications you make to the toolbars or other aspects of Windows. So if you mod-
ify the toolbar and are eventually asked to “Save the Changes to NORMAL.DOT?” click the Yes button to keep your modifications.

Note It’s a bad idea to over-modify the NORMAL.DOT template. If you find yourself making too many modifications,
consider moving them all from the NORMAL.DOT template into another, custom template file you create. That way you
can leave NORMAL.DOT basically “nude,” which may come in handy. Refer to Chapter 5 for information on copying and
deleting information in a template file.

Yes, make the change
to NORMAL.DOT.

Nope, I’m happy with life 
the way I’m living it.
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What’s the Best Way to Alphabetically Sort a List of Items?
Word is entirely capable of sorting text. The problem is that the Sort command is hidden in the Table 
menu. I suppose that’s because Sort is a more powerful tool when it comes to messing with tables. But 
in any event, you can also use the Sort command to sort just any text. Here’s how:

1. Select the text you want to sort. For example, it can be a list of items, each on its own line. If 
you sort paragraphs, then only the first word in the paragraph is used for the sort.

2. Choose Table � Sort. The Sort Text dialog box appears, but you needn’t pay any attention 
to it; it’s already set up to sort alphabetically, A to Z.

3. Click OK. And your text is sorted.

Often what you want to sort is an inline list of items. For example:

My favorite fruits are apples, oranges, bananas, pears, grapes, cherries and 
peaches.

To sort the list of fruit, first edit the paragraph so that each fruit appears on a line by itself:

My favorite fruits are
apples,
oranges,
bananas,
pears,
grapes,
cherries and
peaches.

Now follow the steps above, selecting the fruits only and sorting them by name. You’ll end 
up with:

My favorite fruits are
apples,
bananas,
cherries and
grapes,
oranges,
peaches.
pears,

Now re-edit the paragraphs back into a single sentence, moving the “and” and the punctuation 
into the proper positions, and you have a sorted list.
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This Chunk of Text Is in Latin; How Can I Tell the Spell Checker to Ignore It?
The easiest way to avoid spell-checking foreign words is to format that chunk of text with the foreign 
language’s attribute—yet another seldom-used feature of Word. Here’s how:

1. Select the portion of text in a foreign language—or select any chunk of text that you merely 
don’t want Word to spell-check, such as a code listing, filler block, or whatever you tire of see-
ing flagged as “misspelled.”

2. Choose Tools � Language � Set Language. The Language dialog box appears, described in 
Figure 1.10.

Figure 1.10  

Setting a new lan-
guage for the spell 
checker

3. Scroll through the list until you find Latin.

4. Click OK.

Now the Latin text will be identified as such. In fact, if you had the optional Latin dictionary 
installed, Word would spell check the Latin text.

Optional dictionaries exist for all the languages listed in the Language dialog box. Alas, I’ve had 
a heck of time trying to find or order them from Microsoft. So unless you meet with better luck, I 
suggest merely using the Language dialog box to mark your foreign language text as “Do Not Check 
Spelling or Grammar.” That way, you won’t have to suffer through all the red and green wavy lines.

Printing Fun
The final step to the word processing process is getting your stuff down on paper, the hard copy, the 
printing part. This normally doesn’t even receive a second thought. That is, until you come across one 
of the issues covered in the following sections.

Choose a
new language

from here.

Click this to have
the spell checker
simply ignore the

selected text.

4379.book  Page 19  Tuesday, August 17, 2004  10:53 PM



20 CHAPTER 1 LIFE BEYOND THE BASIC WORD 

Note that some of the items here are printer specific. Your printer’s manufacturer, not Microsoft, 
creates the printer driver, the software used to control the printer. Printing is the spot where Word 
hands over control to that other software. So how your printer works may be subtly different than 
what’s described below.

How Can I Stop Printing?
I find the most satisfying way to stop printing is to stand up and immediately yell at the printer, 
“Stop, you idiot!” This is quite satisfying, but sadly this method has been found to be less than 
effective in most situations.

First, use your printer’s queue list to try to stop the document from printing.
Because your printer is printing, there should be a tiny printer icon that appears in the System 

Tray/Notification Area on the right end of the taskbar. Double-click that little printer icon to open 
your printer’s window and view the queue list.

Click to select your document in the list. Then choose Document � Cancel from the menu (or 
Document � Cancel Printing, depending on your version of Windows).

Wait patiently. Eventually the document will stop printing.
If the document doesn’t stop printing, and the printer keeps spewing out page after page, then con-

sider turning off your printer. Do this only as a last resort: Turn off the printer. Wait a few moments, 
and then turn the printer on again. Eject a page from the printer just in case a page was “stuck” in the 
printer when you turned it off.

How Come the Document Comes out of the Printer Backward?
Many ink printers and a few laser printers spew out their documents face up in the printer tray. The 
result here is that page 1 is always on the bottom of the stack, meaning that you have to reshuffle your 
printer’s output. And aren’t computers supposed to save you time!?

Anyway, it’s entirely possible to have your printer send out its pages in reverse order, providing that 
you remember these steps in Word:

1. Bring up the Print dialog box. Choose File � Print or press Ctrl+P.

2. Click the Options button. This summons a second Print dialog box with a few special options 
custom to Word.

Printing Keys

The printing keyboard shortcut is one of the basic Windows shortcut keys: Ctrl+P.

Another handy keyboarding combination worth knowing is the command to quickly summon the popu-
lar Page Setup dialog box: Alt+F, then U. The F is from File and the U comes from the word “Setup.” Try
to remember those special words as opposed to any others that the F-U combination might make you
think of.
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3. Click to check “Reverse Print Order.” That’s the secret!

4. Click OK.

5. Click OK to print in reverse order, and the pages come out of the printer backward!

Now the last page prints first. If your printer spits out pages face up, then on top of the last page 
comes the next-to-last page, and so on all the way down to page 1, which prints on top the pile.

Can I Print on Both Sides of the Page?
Printing on both sides of a page is tricky. Well, it’s tricky unless you have a printer that’s capable of 
printing on both sides of the page. If you do, then you’ll see the “Print on Both Sides” option deep 
in the printer’s Properties dialog box.

For example, in Figure 1.11 you see the Properties dialog box for my HP color LaserJet, which has 
a dual-sided printing option attached. Alas, most printers lack this option, so you’ll have to do things 
like this:

1. Save your document to disk, all nice and neat and ready to print.

2. Summon the Print dialog box. Choose File � Print or use the handy Ctrl+P keyboard 
shortcut.

3. In the Print dialog box, choose “Odd Pages” from the Print drop-down list. Figure 1.12 shows 
where to find this.

First you want to print pages 1, 3, 5, and so on. Those will go on one side of the paper.

4. Click OK to print.

Figure 1.11  

An option for print-
ing on both sides of 
the page

Here ‘tis.
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Figure 1.12  

Printing odd pages, 
then even pages

And the printing goes on…. When the printing is done, gather the sheets and put them back into 
the printer’s paper tray, but oriented so that printing takes place on the back side.

Further, you need to ensure that the first page is on top and the last page is on the bottom of the 
stack. That’s because page 2 needs to go on the back of page 1, and so on. (See the previous section 
on printing in reverse order, if that helps you stack up your pages properly.)

When the odd pages are properly ordered and oriented in the printer, you’re ready to print on the 
even side.

1. Choose File � Print.

2. Choose “Even Pages” from the Print drop-down list.

3. Click OK, and page 2 prints on the back of page 1, and so on for the rest of your document.

Yes, this can be a pain. It takes a bit of practice and patience to get it right. I recommend starting 
with a simple two-sided, one-page document. Then move up into longer documents. And if this is 
something you plan on doing often, look into buying a printer that has a dual-sided or duplex printing 
option built in. That certainly saves a lot of time and guesswork.

Is There a Better Way to Print on Three-Hole-Punch Paper?
I prefer printing out lots of stuff on three-hole-punch paper. Rather than mess with a paper punch, I 
prefer to buy my printer paper prepunched. As long as the paper is properly oriented when you stick 
it into the printer, everything comes out fine—unless you forget to adjust the margins.

Choose Odd
here first.

The second pass
you’ll choose Even.
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Generally speaking, I prefer a 0.5" margin on the left side of three-hole-punch paper. That gives 
enough room so that my text isn’t too close to the holes. To set the margins that way, you use the Page 
Setup dialog box:

1. Choose File � Page Setup.

2. Click the Margins tab (if you need to). Figure 1.13 shows you what’s up with the Page Setup 
dialog box.

Figure 1.13  

The Page Setup 
dialog box

3. Adjust the Gutter margin up to 0.5". The “gutter” is a typesetting term for the edge of a page 
that is used for binding. Also note in Word 2003 that you can set the Gutter Position for a 
document, though for three-hole-punch paper the position is Left, which is already defined.

4. Click OK, and the margins are properly set for three-hole-punch page printing.

The margins you set for the page are different from the margins set for individual paragraphs. In 
fact, the values you use for a paragraph’s margin are all relative to these page margins. (Paragraph mar-
gins are set by using the Format � Paragraph command.)

How Can I Print Two Pages on an 11 ×××× 14 Sheet?
It’s simple to direct Word to print two or more “pages” on a sheet of paper. The problem comes, 
however, when you want to fold the paper in some way to make a book. Word lacks the smarts to 
intelligently print for binding purposes. (For that task you need a desktop publishing program, such 

Select paper size back here.

Margin-setting
information

Orientation options for
Word 2000 appear back here.

Choose multiple
pages per sheet.

Important preview
information
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as Microsoft’s Publisher or Adobe’s InDesign.) In any event, you can print more than one page on a 
sheet of paper if you follow these steps:

1. Choose File � Page Setup.

2. Click the Paper or Paper Size tab.

3. Select Legal size paper from the Paper size drop-down list.

4. Change the Orientation to Landscape. Note that this is done in the Paper Size tab for 
Word 2000, but in the Margins tab for Word 2003/XP.

5. Click the Margins tab.

6. In Word 2003/XP, choose “2 Pages per Sheet” from the Multiple Pages drop-down list; 
in Word 2000, put a check mark by “2 Pages per Sheet.”

7. Click OK.

Now your document will print two pages on a single sheet. In this case, an 8.5 × 14 sheet of 
legal paper.

Again, the big problem here is binding. While Word can print two pages on a sheet of paper, it’s 
very difficult to glue or staple the multiple pages together to make a book. If you attempt it, then the 
pages will be out of sequence. In fact, it’s just better to print the pages, cut them out (with a scissors), 
then paste them (with glue) into a book form.
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